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Introduction 
 
This document will explain in detail the features related to the module Bid Management in Materials Control. 
 
The minimum required version of Materials Control is 8.7.20.30.1418. This manual is based on version 
8.8.00.47.1491. 

 
 
 

Functionality 
 
The purpose of this module is to offer the purchase department a tool to create a clear analysis of incoming price 
offers.  
This module allows to create lists of articles, so called “Purchase Bids” and could be used to gather prices from 
several suppliers, compare those and create price quotes out of them. 
 
This module offers the following features: 

 Creation of article lists 
 Export/Import of prices 
 Creation of Price Quotes 
 Creation of Assortments 
 Creation of Order Baskets 
 Article Assessments for e.g. “Blind Testing” 
 Supplier Assessments 
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Purchase Bids 
The new module Bid Management is located in the menu section “Purchase”. Here the Bid Lists can be created, 
edited and analysed. 

User Rights: 
 
In order to control the access and use of this module some new user rights were implemented. 
 
 

 
 
Purchase Bids: This user right allows the general access to the module. Please keep in mind that this 

right is required also to access included sub-functions like e.g. Supplier Assessment 
(Please see the chapter below.). 

 
Save Purchase Bids: Having this right a user can create new Purchase Bid Lists as well as edit and save 

existing ones. 
 
Export Purchase Bids: This user right is required to export the Purchase Bid Lists to the listed suppliers. 
 
Import Purchase Bids: This user right is required to import the Purchase Bid Lists returned from the listed 

suppliers. 
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Reason Codes: 
 
At several places in the Bid Management the system will ask for Reason Codes after creation/change of data. 
This is required because every change could have massive impact once an article is quoted with a specific 
supplier.  
 
Some usual Reason Codes could be: 

 Bid Sheet Setup Details edited 
 Manual Price Maintenance (if a price was edited manually) 
 Supplier unlisted (if a supplier was removed from the Bid Sheet) 
 Best Price 
 Best Payback 
 Best Delivery Conditions 

 
 
Besides “normal” Reason Codes also Tendering Codes can be used in the Bid Management module. These 
Codes should be used to explain why a specific supplier was selected. 
It is recommended to create a separate set of Tendering Codes and mark them as such (e.g. with a suffix “(TC)”) 
even if they are sometimes duplicates to the “normal” Reason Codes. 
 
Some usual Tendering Codes could be: 

 Best Price (TC) 
 Best Payback (TC) 
 Best Delivery Conditions (TC) 
 Quality Decision (TC) 
 Management Decision (TC) 

 
Depending on the configuration [BidManagement] > TendCodeMand the use of these codes is mandatory if not 
the cheapest price was selected: 
 

 
 

 
 
These Reason/Tendering Codes should be created in advance. 
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Go to Master Data > Reason Codes: 
 

 
 
Here the required Reason Codes can be created. 

- Enter the Code Name 
- Select the Category “Bid Management” 
- A alpha-numeric Code number can be added (optional) 
- Free text information can also be added (optional) 
- The checkbox “Tendering Code” could be activated to mark this code as such (optional) 
- A color code could be selected per tendering code. 

 

 
 
 
By default the application already shows the cheapest prices with a yellow/green background. In order to align 
this feature now with the Tendering Codes the application automatically creates one Tendering Code on its own: 
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Name:   Best Price (TC) 
Category:  Bid Management 
Code:   BP 
Tendering Code:  active 
Color:    

Up to Version 8.7.30.xx: yellow (default color for cheapest price) 
 
Version 8.8.00.xx and higher: in this version the default color for the cheapest price 
was changed from yellow to green. During the update the application will change all 
existing Tendering Codes using green to white and assign green to the Best Price 
Tendering Code.  
Please make sure that all Tendering Codes have a different color assigned. 
 
Yellow is used for the second cheapest price now when BID_MODE =2. 
Before activating BID_MODE 2, please read the related chapter below. The handling of 
the application will change massively! 

 
 
Except the Name and the Short Code it is not at all recommended to change anything on this record. 
 
Please open the configuration and look for [BidManagement] > TendCode1Label: 
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Here the Tendering Code Name and the Short Code could be adjusted. 
 
 
On the Overview tab the existing Reason Codes can be reviewed and selected for editing as usual: 
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Setup of Purchase Bids: 
 
This chapter will explain the setup and use of Purchase Bids. 
 

 
 
The module itself consists of 7 main tabs: 
 
Overview: 

 On the 1st tab all existing Purchase Bids are listed. 
 
Edit Bid Details: 

 After selecting a Purchase Bid from the Overview or when creating a new one, you can change or define 
the main details, like Time Period and Suppliers. 

 
Evaluation in Base Units: 

 Here the articles will be added. 
 
Evaluation in Units: 

 The main comparison can be viewed under this tab. Also located here are several functions to create 
quotes and assortments. 

 
Import/Export: 

 This tab contains the functions to export and import the Purchase Bid Lists for/from the suppliers. 
 
Supplier Assessment: 

 Here the results of the last assessments done for the suppliers in this Purchase Bid are shown. 
 
Changes/Log: 

 On this tab all changes done in the Purchase Bid can be reviewed. 
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Overview 
 
When accessing the module first the filter dialog is shown: 
 

 
 
This dialog allows to search for a specific Bid Sheet or to adjust the sorting in advance: 
 

 Bid Description: 
Here the user could select directly a specific Bid Sheet: 
 

 
 
 

 Supplier: 
This function allows the user to filter for Bid Sheets on which a specific supplier is listed: 
 

 
 
 



 
 

  Document title  Bid Management 
 Author   Joerg Trommeschlaeger 
 Department  Materials Control 
  Date   14.08.2014 
     Page 12 of 75 

 
 Time Period: 

This option allows to filter for Bid Sheets where the start- and/or end time are in the selected time period. 
 

 Sorted by: 
This section allows to adjust the sorting of the documents in the grid: 

• Bid Description 
o The Bid Sheets are sorted by name in alphabetical sequence 

 
• Status 

o The sheets are sorted by status (Created / Edited / Exported / Closed) 
 

• Owner 
o The sheets are sorted by owner. 

NOTE: Keep in mind that a user can see his own and free documents only! 
 

• Period Start 
o The sheets are sorted by “Period from” starting with the oldest. 

 
• Show Closed Purchase Bids 

o By default all bid sheets in status “Closed” are hidden. This will help to keep the 
overview in the list of documents. 
Mark this checkbox to include the closed bid sheets into the previous filter criterias. 

 
 
 
After selecting the filter options the overview screen shows all valid Purchase Bids. 
 

 
 
Using double click on the column headers it can be sorted by any other criteria listed. 
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Column Description: 
 
A:  Active/Inactive. The records will be shown in red, marked with an X in this column if the 

Purchase Bid was set to inactive. 
 
Bid Description: This is the name of the Purchase Bid 
 
Status:  Here the status of the Bid List is displayed.  

• Created: 
The Purchase Bid was created, period was defined, suppliers and articles were added, 
but nothing else was done.  
 

• Edited: 
Any detail figure was edited either manually or through import. 
 

• Exported: 
The Purchase Bid was exported to at least one supplier. 

 
• Closed: 

The Purchase Bid was closed (see below.) 
 
Owner:  This column shows the owner of the Bid List. The user can see free Bid Sheets and those which 

are assigned to him. 
 
Period from/to: Here the validity time range is shown. 
 
Information: This column shows the content of the “Information 1” field from the section “Note to Supplier”. 
 
Created by/at: In this column the creator and creation-date/time stamp are shown. 
 
Changed by/at: Here the last change date/time stamp and the related user are shown. 
 
Exported by/at: In these two columns the last export to a supplier is recorded with user name and date/time 

stamp. 
 
Imported by/at: In these two columns the last import from a supplier is recorded with user name and date/time 

stamp. 
 
 
Functions: 
Change Owner At the bottom of the screen the button “Change Owner” used to handover the Bid Sheet to 

another user. 
 The application will show here only users which have the user rights to access the module at all. 

The change of the owner will be written into the Bid Header Log. 
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Edit Bid Details 
 
On this tab the main parameters of the Purchase Bid are defined.  
 

 
 
In the header section the Purchase Bid name is shown (and can be edited). 
When you change the name of an existing Purchase Bid, the system will ask you for free text information when 
you try to save. Entry of this information is optional. 
 

 
 
These changes are recorded in the Bid Header Log. 
 
Period from/to: Here the validation range for the Purchase Bid is defined. If the system is 

configured to use the Future Price Quotes functionality, the time period 
entered will also be used for the price quotes. (see documentation 
“132_MC_Future_Price_Quotes”). 
If a user changes the period defined for an existing Purchase Bid, the 
following dialog will be shown when you click save: 
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Here the user must enter a free text information and must select a reason 
code. Both fields are mandatory! This change will be recorded in the Bid 
Header Log. 
(See chapter Reason Codes) 
 

Return Bid until: Define expected Return Date for supplier prices. This field is also shown in 
the Excel Export sent to the supplier. This date cannot be defined on a past 
date. 

 
Note to Supplier: 
Information 1 & 2:  Free text information field 
 
Conclusion:   Free text field to enter a final conclusion for this Purchase Bid. 
 
Excel Summary Export Version: Here a version counter is shown. This number shows the consecutive version 

number of the Excel Export done on the tab “Evaluation in Base Units”. For 
further details please see the related chapter below. 

 
 
Supplier Grid (right side): 

- Supplier Selection field: Here the suppliers to be added can be selected. 
- Supplier:  This column shows the supplier name. 
- Customer Number: This is the main customer number. Customer numbers per cost center /store  

are not shown since a purchase bid is not related to a specific cost center. 
- Notes:   Here the content of the Information field in Supplier >  

    Contract Information is shown. 
- Assessment:  If there have been any previous for this supplier the  

average grade of the last assessment is displayed here. If at least one detail 
grade was higher than 3 it will be shown in red!  
(For details about Supplier Assessments please see the related chapter 
below.) 
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If a user adds a new supplier to an existing Purchase Bid, at saving the system will show the following dialog: 
  

 
  
Here the user must enter a free text information and must also select a reason code. Both fields are mandatory! 
This change will be recorded in the Bid Header Log. 
(See chapter Reason Codes) 
Suppliers can be removed on the tab “Evaluation in Units”. 
 
 
Toolbar -> Print/Preview: 
 
From the current tab the Summary Reports also can be printed. 
 

 
 
Purchase Bid Cover Sheet 
 

 
 
This report shows the data from the tab “Edit Bid Details”. 
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The following four lines are Report Batches defined as below: 
 
“Purchase Bid Summary with History” will print: 

• Purchase Bid Cover Sheet 
• Bid Management with PH 
• Evaluation in Units 
• Best Price Differences 

 
 
“Purchase Bid Summary w/o History” will print: 

• Purchase Bid Cover Sheet 
• Bid Management without PH 
• Evaluation in Units 
• Best Price Differences 

 
 
“Purchase Bid Summary (incl. Log) with History” will print: 

• Purchase Bid Cover Sheet 
• Bid Management with PH 
• Evaluation in Units 
• Bid Header Log 
• Bid Detail Log 

 
 
“Purchase Bid Summary (incl. Log) w/o History” will print: 

• Purchase Bid Cover Sheet 
• Bid Management without PH 
• Evaluation in Units 
• Bid Header Log 
• Bid Detail Log 

 
 
Definition of Terms: 

• Bid Management with PH 
This report shows details from the tab “Evaluation in Base Units” including figures from the loaded 
Purchase History. 

 
Bid Management without PH 

• This report shows details from the tab “Evaluation in Base Units” without figures from the loaded 
Purchase History. 

 
Evaluation in Units 

• This report shows the details from the tab “Evaluation in Units”. 
 
Best Price Differences 

• This report shows a comparison between the selected/preferred price and the best price listed in the 
Purchase Bid. This report can be printed from the tab “Evaluation in Units” as well. 

 
Bid Header Log 

• This report shows all entries from the tab “Changes/Log” > “Header Log”. 
 
Bid Detail Log 

• This report shows all entries from the tab “Changes/Log” > “Detail Log”. 
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Save as … 
In the “File” menu the system also allows to use the function “Save as …”. This allows the user to create copy of 
the current Purchase Bid for i.e. recurring Bids. 
 

 
 
After definition of the name for the new Purchase Bid the validation time range must also be defined. After 
confirmation with “OK” the system will ask again for free text information: 
 

 
 
This text is optional. Once confirmed again the system will create a fresh copy of the previously selected 
Purchase Bid, but this time without prices. 
 
Functions: 
Close Purchase Bid This function allows to close a Purchase Bid. When pressing this button the application 

will ask for confirmation: 
 

 
 
Once confirmed the Purchase Bid will be set to “read-only”. No figures can be changed 
anymore. Also export and import are no longer possible. 
 
Viewing/printing of reports still is possible. 

 
Change Status This function allows to set the current purchase bid to any status. On click the following 

screen comes up: 
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The current status always is selected at the top and must be changed manually to 
avoid accidental changes. 
 
To change the status here manually the application always requests some information 
as text which is stored in the Bid Header Log. 
 
NOTE: This function also allows to re-open already closed Bid Sheets! 

 
 
 
 
 
 
 
 
  



 
 

  Document title  Bid Management 
 Author   Joerg Trommeschlaeger 
 Department  Materials Control 
  Date   14.08.2014 
     Page 20 of 75 

Evaluation in Base Units 
 
Here the content of the Purchase Bid is defined. 
 

 
 
Screen Details: 
 
Toolbar: 
New: Click here to create a new Purchase Bid. The system will 

switch to the tab “Edit Bid Details”. 
 
Open:  Clicking this icon will open the search dialog and then switch 

to the “Overview” tab. 
 
Save: Click this icon to save the Purchase Bid in the current state. 

Depending on the last changes the system will ask for a text 
note and/or a reason code (partially mandatory!).  

 
Refresh:   Refresh of current view. 
 
Print/Preview: These two functions allow you to select which report you 

would like to view/print. Currently 2 reports are available: 
o Bid Management with/without Purchase History 
o Best Price Differences 

 
Excel: Export of current grid to MS Excel. 
 Based on the configuration [BidManagement] > 

EvalBUnitExp_RO this export is write protected by default.  
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 If required the protection could be removed via (MS Excel) 
“Review” > “Unprotect Sheet”. 

   
 Please see the separate chapter below explaining the 

exported Excel sheet. 
 
Delete:   Click here to delete the Purchase Bid. 
 
Grid: 
AL:   Authorization Level assigned to the Article. 

This column could be hidden. Activate the configuration 
parameter [NAMES] > UseAuthorizationLevels: 
 

     
 
Pos:   Position Number for Sorting 
 
Article:   Article Name 
 
{Product Specification}: If activated: This column shows the first 30 characters of the 

content of the Article Master Data > Product Specification. 
 
Unit:  This is the base unit of the Article 
 
{QTY PP}: If activated: Total quantity in base unit purchased during the 

selected Purchase History Period 
 
{AVE/Last Pr. PP}: If activated: Average or Last Price, calculated from purchase 

in the selected Purchase History Period. 
  Based on the selected price type also the column description 

is changed: 
 Last Pr. PP: Last Price of previous period 
 AVE Pr. PP: Average Price of previous period 

 

  
 



 
 

  Document title  Bid Management 
 Author   Joerg Trommeschlaeger 
 Department  Materials Control 
  Date   14.08.2014 
     Page 22 of 75 

{Total PP}:  If activated: Total sum of QTY PP * (AVE Pr. PP or Last Pr. 
PP) 

 
{PP Supplier}:  If activated: Last Supplier (available only if Price Method “Last 

Price” was selected in Purchase History) 
 
Pref. Price:   Selected Price from listed Bids 
 
Pref. Supplier:  Supplier for selected Price 
 
T. Code:  Selected Tendering Code. 

If prices are available: The system will automatically assign 
the (internally created) Tendering Code “Best Price (TC)” to 
the position having the cheapest price and mark the price 
records green. This can be changed then manually. 
Just click into the field and select the Code from the list: 

 
 
The selected price will now, instead of the green background, 
be marked in the color assigned to the selected Tendering 
Code. 
 
If no prices are available: The field will be blank. No Code 
could be selected until a price was entered. 
For further details please read the related chapter. 
 

{Supplier Name}: For each supplier the prices will be listed in a separate 
column. In case of existing Supplier Assessments the average 
rating will be displayed bracketed () in the column header. 

 
{Tot. [Supplier Name]}: If activated: QTY PP * Supplier’s Price 
 
{Assm.}: If activated: In case of existing Article Assessments the results 

for the supplier’s sample will be shown here. 
 
Best Price: This column shows the best price available in the current 

Purchase Bid. 
 
Selected Price: Selected Price from listed Bids 
 
BP/SP Difference Difference in value between best and selected price. 
in Amount: 
 
BP/SP Difference in %: Deviation in % between best and selected price. 
 
Prev. Period Price: AVE price from Purchase History Period 
 
PPP/SP Difference Difference in value between selected and Prev. Period Price. 
in Amount: 
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PPP/SP Difference in %: Deviation in % between selected and Prev. Period Price.  



 
 

  Document title  Bid Management 
 Author   Joerg Trommeschlaeger 
 Department  Materials Control 
  Date   14.08.2014 
     Page 24 of 75 

Buttons/Flags: 
Add Position:  Click this button to add one or more articles to the 

Purchase Bid. The following dialog is displayed: 
 

 
  
 Two options are available: 

o Item Group: The system will load all articles 
assigned to the selected item group into the 
Purchase Bid. 

o Article: The system will add the selected article to 
the Purchase Bid. 

 
Reorganize Pos: This function can be used to influence the sorting within the 

Purchase Bid. The system sorts by default by article name. 
Click on this button to generate a position number for each 
row. Now the user could manually adjust these numbers to 
change the sorting.   

 
Delete Flag: Mark a record and click on this button to remove (mark for 

removal) a position from the Purchase Bid. At saving the 
Purchase Bid the system will show the following dialog: 

  

  
   
 Here the user must enter some free text information and 

must also select a reason code. Both fields are mandatory! 
This change will be recorded in the Bid Detail Log. 

 (See chapter Reason Codes) 
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Summary:   Click this button to view the summary of the current bid: 
 

     
 
Here the system lists all articles and their prices from each 
supplier. 
Fields marked in green show the price that is the preferred 
Bid. 
At the bottom the system shows two total figures per column: 

o TOTAL: 
This is the Total Sum of the prices marked as 
preferred from this supplier. 

 
o Percentage of Total Articles: 

This is the percentage of all articles where this 
supplier is marked as preferred. 

 
This view also can be exported to Excel using the button 
“Export to Excel” in this screen. 
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Purchase History: This function allows to load the purchase data for the listed 
articles in a defined time range. These figures could be used 
to estimate the expected quantities. 

   
 

 

 
 
 This dialog offers three main functions: 

o Get New Purchase History Data 
Here the user can define which data should be 
considered: 

 Time Period From/To: 
The system will calculate all deliveries from 
all suppliers in the defined time period.  

 Price Method 
Defines the price to be used for the PP (Past 
Period) calculations. 
“Last Price” will be the absolute last price. 
“Average Price” will result in the average 
price of all deliveries in the defined period.  

In addition to this the absolute last supplier can be 
displayed as well by marking the checkbox “Show 
Last Supplier”. In this case and option “Last Price” is 
selected, the system will use the last price from this 
supplier. 
Based on the selected price type also the column 
description is changed: 

• Last Pr. PP: Last Price of previous period 
• AVE Pr. PP: Average Price of previous 

period 
 

o Use Saved Purchase History Data 
Previously loaded Purchase History can be 
reactivated and displayed again. 
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o Hide Purchase History 
In case of a previously loaded Purchase History this 
option can be used to hide it on the screens. It still 
will be saved with the Purchase Bid and can be 
reactivated afterwards. 

 
All changes will be recorded in the Bid Header Log. The user 
could add optional free text information for explanation. 

 

      
 

NOTE 1: If the purchase history was loaded before creating 
the export files, these quantities will also be exported! This 
information is required for the supplier to calculate the prices. 
 
NOTE 2: Once the purchase History is loaded, there are 
several more fields visible on the Excel Export. 

 
 
Product Specification: Activate this checkbox to display the first 30 characters of the 

content of Article Master Data > Product Specification. 
 
Article Assessment Results: Activate this checkbox to display the existing Article 

Assessments results for the supplier’s sample in an additional 
column per supplier/article.. 

 
 
 
Additional Functions: 
There are several functions available directly in the grid. 
 
- Click in the column “Pos”: Here the user can manually adjust the position number of 

an article within the list. After editing use the “Save” function to re-sort the list. 
- If Purchase History is loaded: 

o Click in QTY PP: Here the user could adjust the loaded figure calculated from 
the purchase history. At saving the following dialog is displayed: 
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Here the user must enter a free text information and must also select a 
reason code. Both fields are mandatory! This change will be recorded in the 
Bid Detail Log. 
(See chapter Reason Codes) 
 

o Click in AVE Pr. PP: Here the user could adjust the price calculated by the 
system. At saving the following dialog is displayed: 
 

 
 
Here the user must enter a free text information and must also select a 
reason code. Both fields are mandatory! This change will be recorded in the 
Bid Detail Log. 
(See chapter Reason Codes) 
 

o Click in PP Supplier: Here the user could replace the last Supplier. At saving 
the following dialog is displayed: 
 

 
 
Here the user must enter a free text information and must also select a 
reason code. Both fields are mandatory! This change will be recorded in the 
Bid Detail Log. 
(See chapter Reason Codes) 
 

- Double click on any field will open the following dialog: 
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This screen shows the prices for the selected article per supplier for Base Unit and 
Unit. If already one supplier is marked as preferred the prices will be shown in green. 
The following functions are available in this screen. 

o Click into the field showing the unit price: 
Here the user could manually change the price for the packing unit. 
 

o Double click on any price field: 
This allows the user to change the preferred supplier for this position. The 
following dialog is shown: 
 

 
 
Here the user must enter a free text information and must also select a 
reason code. Both fields are mandatory! This change will be recorded in the 
Bid Detail Log. 
 
Depending on the configuration [BidManagement] > TendCodeMand it may 
be required that also the Tendering Code must be selected: 
 

 
 
(See chapter Reason Codes).  
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Evaluation in Base Units – Excel Export 
 
The following chapter will explain the Excel export from the tab “Evaluation in Base 
Units”. 
 

 
 
Depending on used functions and activated configuration parameters the layout of the file 
may change. 
 
Export Path Definition: 
 
 Activation: Configuration [BidManagement] > BidXlsExp_Path 
 
Here a default export path can be defined. This is valid for all users. 
 

 
 
If this path is accessible, the system will not ask for the export destination, but create the 
file at the defined location directly. 
If the path is not accessible or not defined, the system will show the usual dialog where 
the user could select the destination folder and also could adjust the file name. 
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NOTE: Please make sure that all users have sufficient rights to access this directory as 
well as reading and writing (creation of files) must be allowed! 
 
 
 
Export File Naming: 
 
 Activation: None 
 
By default the system will create the name of the export file as follows: 
{Bid_name} YYYY MM TT HH MM SS Version nnn.XLS 
 
{Bid_name} > shows the name of the Bid Sheet 
YYYY  > shows the current year 
MM  > shows the current month 
DD  > shows the current day 
HH  > shows the current hour (24h) 
MM  > shows the current minute 
SS   > shows the current second 
Version > shows the term “Version” 
nnn > shows the current sequential version number (please see 

below!) 
.XLS  > default file extension 
 
Example: 
Meat Testing 2012 06 29 13 19 37 Version 33.XLS 
 
If there is no default path defined or the defined one is not accessible, the system will 
show the usual dialog where the user could select the destination folder and also could 
adjust the file name. 
 
 
Export File Deletion: 
 
 Available until version 8.10.40.1528 and older only! 
 Activation: None 
 
After creation of an export the application will try to delete the previous export file. 
 
To find the file the system will simply use the name of the current export file and the look 
for the current counter -1. 
 
In case the file cannot be found or cannot be deleted (access violation, missing rights, 
etc. …) the following message will be shown:  
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NOTE: This function will not be available anymore in version 9.00.xx and higher. It 
must not be possible to delete local files from a browser application! 
 
 
Field Formatting: 
 
 Activation: Configuration parameters in section [BidManagement]. 
 
The following will allow to define the number of decimals for quantities and monetary 
values in the Excel export sheet. 
NOTE: This will not affect the decimals shown in the application on screen! 
 
Format for monetary values: 
 

 
 
This parameter allows to define… 
 … if the system currency symbol should be shown. 

To activate this, define a “T” at the beginning. The application will now look for the 
system currency definition and add this as a suffix to the value. 
 

 … how many decimals should be shown 
 
Above configuration “T2” will show the figures like this: 
 

 
 
If nothing is defined here, the system will not show any symbol and follow the general 
settings done for price formats. 
 

  



 
 

  Document title  Bid Management 
 Author   Joerg Trommeschlaeger 
 Department  Materials Control 
  Date   14.08.2014 
     Page 33 of 75 

Format for quantities: 
 

 
 
This parameter allows to define the number of decimals to be used for quantities. 
 

 
 
If nothing is defined here, the application will show three decimals per default. 
 
 
Supplier Contract Information: 
 
 Activation: Purchase History must be loaded into the Bid Sheet. 
 

 
 
At the bottom of each supplier column set the system now shows the Sconto and Volume 
Discount Information stored in the Supplier setup: 
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Bid Sheet Summary: 
 
 Activation: Purchase History must be loaded into the Bid Sheet. 
 

 
 
On the left side, just under the main article grid, the system will show the summary for 
this Bid Sheet. 
Here the following figures are compared: 
- Grand Total PP 

This is the total sum of the purchase based on the loaded (and maybe edited) 
Purchase History. 

- Pref. Pr. Grand Total 
This figure shows the total sum of the selected prices multiplied with the expected 
QTYs based on the loaded (and maybe edited) Purchase History. 

- Difference in Value 
This field shows the difference between the two above shown values. 

- Difference of above in % 
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Tendering Code Legend & Summary: 
 
 Activation: Purchase History must be loaded into the Bid Sheet. 
 

 
 
On the left side, just under the Bid Sheet Summary, the system will show a color legend 
and a summary per used Tendering Code. 
 
 
 
Bid Sheet Conclusion: 
 
 Activation: None. This field will always be exported. 
 

 
 
At the bottom of the sheet the system now will display the content of the field 
“Conclusion” from the tab “Edit Bid Details”: 
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Evaluation in Units 
 
This tab is the main work area during the Purchase Bid processing. 
 

 
 
The grid here shows all articles added on the previous tab including their currently used 
units from the module Price Quotes. On the right part of the screen the different prices 
per supplier per base unit and packing unit are displayed. 
Also the functions to generate Price Quotes, Order Baskets and Assortments are located 
here. 
 
Screen Details: 
 
Toolbar: 
New: Click here to create a new Purchase Bid. The system will 

then switch to the tab “Edit Bid Details”. 
 
Open:   This icon will open the “Overview” tab. 
 
Save: Click this icon to save the Purchase Bid in the current state. 

Depending on the last changes the system will ask for a text 
note and/or a reason code (partially mandatory!).  

 
Print/Preview: These two functions will open a report selection box. From 

here the report “Evaluation in Units could be printed. 
 
Excel:   Export of current grid to MS Excel 
 
Delete:   Click here to delete the Purchase Bid. 
 
 
 
Grid: 
The first 4{5} columns are fixed and will always be displayed at the left side of the screen. 
 
Article:   Article Name 
 
{Product Specification}: If activated: This column shows the first 30 characters of the 

content of Article Master Data > Product Specification. 
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Unit: The application here shows all available packing units for the 
article. These are initially read from the current valid price 
quotes, but additional units could be added manually as well. 

 
Pref. Price:  This column shows the preferred price. This will either be the 

cheapest (automatically selected) or a manually selected one. 
 
Pref. Supplier: This is the Supplier with the selected Price. In case that no 

manual selection and also no automatic selection are 
possible (identical prices) this column will be displayed as 
“Undefined”. 

 
Following the fixed area now two columns per supplier are displayed: 
{Supplier Name} BU Price: This column shows the price recalculated in Base Unit. This 

is useful if the suppliers transmitted pricings for different 
packing units. 

 Example: 
 Supplier A offers € 3,06 per 180 grams 
 Supplier B offers € 62,96 per 20 x 180 grams 
 Here only the price in Base unit will show comparable prices 

for the user (€ 17,00 vs. € 17,49).  
 
{Supplier Name} Unit Price: This column will show the price per packing unit. 
 
Preferred Prices are shown in the cells marked green. If you have not chosen any other 
preferred price manually the system will select the lowest price in BU automatically.  
In case of identical prices in base units the system will show these prices in red filled cells 
(see record no. 4 in screen shot above). 
 
 
At the bottom of the grid some totals for some columns are displayed: 
 
Pref. Price:    This is the total sum of all preferred prices. 
 
{Supplier Name} BU Price:  
        Total: Here the sum of all prices in BU for this supplier is  

displayed. This value allows the comparison of the 
suppliers if more than one of them could offer all 
prices. 

Percentage of Total Articles: This figure shows the percentage value of the prices 
given by this supplier. It will show i.e. 100% if the 
supplier has given prices for all positions. 
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Buttons/Flags: 
Reset to Proposal: This function will undo all eventually manually done 

selections of the preferred supplier and will select the 
cheapest supplier for all positions. The following dialog is 
shown: 

 

  
 

Here the user must enter a free text information and must 
also select a reason code. Both fields are mandatory! This 
change will be recorded in the Bid Detail Log. 
(See chapter Reason Codes) 

 
Accept Quotes: This function allows to create price quotes out of the listed 

prices.  
 

    
    
     

In the upper section of the dialog the user could select the 
Price Quote parameters, in the lower section the user must 
select for which records the quotes should be created.  
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The system will use the price behaviour defined in the source 
article mast data records: 
 

 
 
If the article was defined to use dynamic prices, the price 
quotes will be created with this definition as well. 
 
Example: 
 
It is possible to have a DPQ for Carrots in KG and another 
DPQ for Carrots in Case/5KG. 
For all records to be considered based on selection in “Apply 
Changes to” during creation of the price quotes… 
… System will set E/D if checkbox marked. 
… System will set Contract if checkbox marked. 
… System will set DPQ if checkbox marked and if record is 
defined as “Preferred” in Bid Sheet. 
… for all positions not defined as Preferred, no DPQ will be 
set. 
 
For all records from above result set which are preferred in 
the Bid Sheet the system will search in the Price Quotes and 
remove eventually existing DPQ flags where combination 
[Article + Packing Unit] is exactly the same. 
 
As a result of this e.g. the DPQ for Carrots in Case/5Kg could 
have been updated to the new supplier from the Bid Sheet, 
but the DPQ for Carrots in KG from other supplier remains, if 
there is no new DPQ from Bid sheet for Carrots/KG. 
 
In case of no new DPQ from the Purchase Bid the system will 
keep the origin DPQ. 
 
The application will use the Purchase Bid Period definitions 
for the price quotes if the system is configured to use the 
Future Price Quotes functionality (see documentation 
“132_MC_Future_Price_Quotes”). 
 
Here also the import of the External Article Number and the 
Information could be enabled. 

 
 
Remove Supplier: This function could be used if a supplier should be removed 

from this Purchase Bid. Mark a supplier column and click on 
the button “Remove Supplier”: 
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After confirmation with “Yes” the system will ask for the 
reason: 
 

 
 
Here the user must enter a free text information and must 
also select a reason code. Both fields are mandatory! This  
change will be recorded in the Bid Detail Log. 
(See chapter Reason Codes) 

 
Summary: Click this button to view the summary with units of the current 

bid: 
 

     
Here the system lists all articles and their prices from each 
supplier. 
Fields marked in yellow designate that this price is selected as 
preferred Bid. 
Fields marked in red show that no price has been selected as 
preferred Bid. 
At the bottom of the grid the system shows two total figures 
per column: 

 TOTAL: 
This is the Total Sum of the prices marked as 
preferred from this supplier. 

 Percentage of Total Articles: 
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This is the percentage of all articles where this 
supplier is marked as preferred. 

This view can also be exported to Excel using the button 
“Export to Excel” in this screen. 
 
By double clicking into the supplier columns also here the 
prices can be edited and/or the preferred supplier could be 
changed. Same as in the main screen the system will ask for 
information and reason codes after changing the details. 
 

Add Unit: Use this function to add a unit for a selected article. Mark the 
article and click on the button: 

 

     
     

Select the new unit from the list and confirm with OK. The 
application will now insert a new row for this unit.  
 

 
Create Article Assortment: This function allows to create an assortment out of the 

selected/all positions. 
 

     
     

After selection of the positions and the cost center the 
application will ask for the assortment owner: 
 

 
 
Now the name of the Assortment must be defined: 
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This could be either a free definable name or a system 

generated by using the button .  
 

If no specific name was entered and the  
function is used, the application will use the Bid Sheet name 
concatenated with YYYYMMDDHHMMSS 
 
Example: 
Meat Testing 20130411014256 
Bid Sheet Name Meat Testing 
Year   2013 
Month   04 
Day   11 
Hour (12h)  01 
Minutes  42 
Seconds  56 
 
… This assortment was saved on April 11th 2013 at 13:42:56. 
 

 
 
If the assortment name was entered manually and there is 
already one named exactly the same, the system will show 
the following message: 
 

 
 

o Yes: The system will overwrite the existing 
assortment with the new one. 
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o No: The system will close this message box and 
return to the Assortment Name dialog. 
 

At the end the application will show the confirmation: 
 

 
 
The new assortment now can be found in the Purchase Order 
module named as defined above. 

 
 
Create Supplier Assortment: This function could be used to create assortments per  
    Supplier out of the selected/all positions. 
 

     
After selection of the positions and the cost center the 
application will ask for the assortment owner: 
 

 
 

Now the name of the Assortment must be defined: 
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This could be either a free definable name or a system 

generated by using the button .  
 

If no specific name was entered and the  
function is used, the application will use the Bid Sheet name 
concatenated with YYYYMMDDHHMMSS 
 
Example: 
Meat Testing 20130411014256 
Bid Sheet Name Meat Testing 
Year   2013 
Month   04 
Day   11 
Hour (12h)  01 
Minutes  42 
Seconds  56 
 
… This assortment was saved on April 11th 2013 at 13:42:56. 
 

 
 
If the assortment name was entered manually and there is 
already one named exactly the same, the system will show 
the following message: 
 

 
 

o Yes: The system will overwrite the existing 
assortment with the new one. 

o No: The system will close this message box and 
return to the Assortment Name dialog. 
 

At the end the application will show the confirmation: 
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The new assortment now can be found in the Purchase Order 
module named as defined above. 
 
 

Create order Basket: Use this function to create an Order Basket out of the 
Purchase Bid. 

     

          

After selection of the positions and the cost center the 
application will confirm the creation of the basket: 
 

 
 
Product Specification: Activate this checkbox to display the first 30 characters of the 

content of Article Master Data > Product Specification. 
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Additional Functions: 
There are three functions available directly in the grid. 
 
- Double click in the column “{Supplier Name} BU Price”: This will define the selected 

supplier as Preferred Supplier. 

 
 

Here the user must enter a free text information and must also select a reason code. 
Both fields are mandatory! This change will be recorded in the Bid Detail Log. 
(See chapter Reason Codes) 

 
- (single) Click in the column “{Supplier Name} Unit Price”: Here the user could enter 

the price manually or adjust the imported ones. At saving the following dialog is 
displayed: 

 
 

Here the user must enter a free text information and must also select a reason code. 
Both fields are mandatory! This change will be recorded in the Bid Detail Log. 
(See chapter Reason Codes) 
 

- Double click in the column “{Supplier Name} Unit Price”: This will define the selected 
supplier as Preferred Supplier. 

 
 

Here the user must enter a free text information and must also select a reason code. 
Both fields are mandatory! This change will be recorded in the Bid Detail Log. 
(See chapter Reason Codes).  



 
 

  Document title  Bid Management 
 Author   Joerg Trommeschlaeger 
 Department  Materials Control 
  Date   14.08.2014 
     Page 47 of 75 

Import/Export 
 
This tab offers the functions to export the Purchase Bid to the suppliers and to import the 
edited lists again. 
 

 
 
The left side of the screen shows all functions & features related to the export; the right 
side offers the import function. 
 
Export Data: 
 
This function should be used to create the price lists to be sent to the suppliers. 
 
Export Format: 
- PDF   Select this option to generate the Purchase Bid lists as PDF  

files. Please keep in mind that such files cannot be edited 
and as a result of this no automated import is possible. The 
prices returned by the supplier then must be entered 
manually. 
 

 
 

- XLS   Select this option to generate the Purchase Bid lists as Excel  
sheet. This Excel sheet contains two tabs, one cover page 
and a detail page. 
The cover page contains general information: 
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Description  Bid Sheet Name 
Created  Creation Date of the Export File 
User   User Name (at creation of the export) 
Application  Always “Materials Control” 
Valid from  Start Date for Bid Sheet Pricing 
Valid to  End Date for Bid Sheet Pricing 
Supplier  Supplier for this Export Sheet 
ID   internal ID 
Supplier Account Account Number for this Supplier 
Supplier Telephone Phone Number for this Supplier 
Supplier Fax  Fax Number for this Supplier 
Supplier Contact Contact Name for this Supplier 
Supplier Email  Email Address for this Supplier 
Return Date Expected Return Date for the Supplier 

Prices 
Supplier ID  Internal Supplier ID 
 
All data here is read-only.  
 
Detail Page: 
The supplier could enter his prices directly into this template 
and return it to the sender. These files can be imported 
directly into the Purchase Bid. 
 

 
 
Column explanation for the Excel Export: 
 
A & B 

o These columns are hidden since they are used 
internally only 

C / Art. Number intern 
o Here the internal article number is shown. 
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D / Art. Number extern 
o Here the external article number (Purchase Article / 

Price Quote) is shown. This column is editable for 
the supplier. 
 

 
 

 
 

E / Article 
o Here the article name is shown. 

F / Product Specification 
o If activated the first 30 characters of the Product 

Specification (from Article Setup) are shown here. 
G / Unit 

o This is the name of the Packing Unit. 
H / Packing Content 

o This is the QTY in Base Unit contained in the 
Packing Unit. 

I / Estimated QTY 
o This is the estimated QTY based on the loaded 

Purchase History. If no PH was loaded the column 
will show 0 for all positions. 

J / Price new 
o Here the supplier should enter his price offer for the 

article. This column is editable for the supplier. 
K / Info 

o Information. Here the supplier could enter some 
details regarding his price for this position. This 
information will be imported into the bid sheet and 
into the price quote created out of this bid. 
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NOTE: All columns are write-protected by default (see 
[BIDMANAGEMENT] > EvalBUnitExp_RO). The supplier 
should/can insert his specific article numbers (column D) and 
his prices (column J) for the existing records only! 
This write-protection could be secured with a password. Go 
to System > Configuration > FBV8.INI > [BIDMANAGEMENT] 
> PW_EXPORTFILE: 
 

 
 
If blank: The protection could be removed via (MS Excel) 
“Review” > “Unprotect Sheet”. But then the import could fail if 
the supplier has done any changes in the layout. 
 
Is any password is entered: MS Excel will ask for the 
password to unprotect the exported sheet. 
 
Depending on the settings System > Configuration > 
FBV8.INI > [NAMES] > XLSVERSION the application will 
export in XLS (Office 97-2003) or XLSM (Office 2007 and 
higher) format. 

 
 
Transport: 
- File Export  This option will create the export file at a defined location (see  

   below “File:”). 
o File:  Define the location for the file export (if option “File Format”  

  was selected). 
In this case the system will use the defined file name and 
concatenate it with the supplier name. 
Example: 
 

 
 
The file to be export is defined as 
D:\BID_EXPORT\Softdrinks.xls. 
 
At Export the application creates the files at the defined 
location using the defined file name and the supplier names: 
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- Send via Email  Using this option the export files will be transmitted via Email  
   to the supplier. 
    

The application now shows a screen to select either all or just 
selected suppliers for which the email should be sent: 
 

    
    

In this case the application will combine the Bid Sheet Name 
and the supplier name: 

    

    
    
 

 
 

Bid Sheet Covering Letter: 
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The system offers to send a cover letter together with the export file. This letter should 
contain, besides the salutation and information about the purchase bid, also some 
instructions how the export file should be used.  
- Description of the columns 
- No records must be added/removed 
- No columns must be added/removed 
- Edit the price column only 
- Use correct punctuation (regional settings of sender!) 
 
Here on the tab “Import/Export” the standard Cover Letter will be defined. This cover 
letter will be used for all Purchase Bid Exports via Email. 
 
Browse to the document which should be defined for this and click on “Save 
Configuration” afterwards. 
 
As exception also Cover Letters per supplier could be defined. Go to Master Data > 
Suppliers and select the supplier. Now switch to the last tab named as “Contract 
Information”. Here the alternate Cover Letter for the selected supplier could be defined. 
 

 
 
Export: This function will start the export based on the selected 

parameters. In case of Export via Email the system asks for 
(optional) information: 
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Save Configuration:  This button can be used to save the file name and location as 
default values for this purchase bid. 
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Import Data: 
 

 
 
 
This function is used to import the previously exported EXCEL files after the suppliers 
have entered their prices. 
 
The first field allows to select the supplier for which the prices should be imported: 
 

 
 
The import is done by supplier. In the next field the user must select the file he wants to 
import. 
 
The table in the section “Import Status” shows the suppliers listed for this bid sheet and 
their import status. This allows to easily identify when the last import for a supplier was 
done and which ones are still outstanding.  
Each time any further export for a supplier is done, the “Last Import” time stamp is 
cleared again. 
 
Load: After selecting the supplier and the file this button will start 

the import. After importing the prices from the Excel sheet the 
system will ask for some (optional) information … 
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 … and display a log file entry for this import: 
 

   
 
Save Configuration:  This button can be used to save the file name and location as 

default values for this purchase bid. 
 

 
All Exports and Imports will be logged in the Bid Sheet Header Log: 
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Supplier Assessment 
 
This screen shows the latest Assessments for the Suppliers listed on the current 
Purchase Bid: 
 

 
 
In the bottom line the average grades per criteria are displayed. 
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Changes/Log 
 
Here all recorded changes are collected. This tab is divided into two sub tabs, one for 
changes related to the Purchase Bid Header (tab “Edit Details”) and another one for the 
Purchase Bid Details (tabs “Evaluation in Base Unit/Unit”). 
 
Header Log: 
 

 
 
The entries are listed sorted by ascending date. As in most of the other screens in 
Materials Control the sorting could be changed by double click the column headers. 
 
Columns: 
Action:  This column shows the function where changes were made. 
 
Reason Code: Here the selected Reason Code (when applicable) is displayed. 
 
Changes:  This is the detailed description of the changes made. 
 
Information: This field shows the free text information entered by the user (when 

applicable). 
 
Changed by/at: User Name and Date/Time Stamp of the action. 
 
Print/Preview: This log could be printed. 
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Excel:  The usual Excel Export function allows to export the displayed data. 
 
 
 
Detail Log: 
 

 
 
The entries are listed sorted by position number and date ascending. As in most of the 
other screens in Materials Control the sorting could be changed by double clicking on the 
column headers. 
 
 
Columns: 
Pos:  Position Number of the article in the Purchase Bid. 
 
Article:  Article Name 
 
Reason Code: Here the selected Reason Code (when applicable) is displayed. 
 
Changes:  This is the detailed description of the changes made. 
 
Information: This field shows the free text information entered by the user (when 

applicable). 
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Changed by/at: User Name and Date/Time Stamp of the action. 
 
Print/Preview: This log could be printed. 

   

    
    

    
 
Excel:  The usual Excel Export function allows to export the displayed data. 
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Supplier Assessment: 
 
This function is located in the module Bid Management and could be used to assign 
grades or scores to the suppliers. 

User Rights: 
 
In order to access and use this module, two new user rights must be set: 
 

 
 
View Supplier Assessment: This right allows read-only access to this module. 

The user can view entered assessments, but no 
changes are possible. 

Edit Supplier Assessment: The user can create new assessments and view and 
edit existing ones. Having this user right also 
assessments created by other users could be edited. 

 
NOTE: The user must have the user rights “Purchase Bids” to access the main module in 
general, before he could start the Supplier Assessment! 
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Setup of Assessments: 
 
This module could be used with or without the Bid Management. In order to activate this 
for the Bid Management as well please open System > Configuration > [CUSTOM]: 
 
Here you can find the parameter SUPPLIERASSESSMENT. 
 

 
 
Set this parameter to T in order to activate the use of this module in the Bid Management. 
 

 
 
Start the module Bid Management and select from the main menu the section 
“Assessment”. Here you can find the module “Supplier Assessment”. 
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In the header section the supplier must be selected.  
In the grid below the details of the assessment are displayed. 
 
Select any supplier and click on “New Assessment”: 
 

 
 
This dialog shows 10 fields where the different grades can be entered plus one additional 
free text information field for details about this assessment. 
 
The labels for the 10 fields are free definable, but are valid for all supplier assessments. 
They should show the criterias you want to use for the supplier assessments, such as… 
- Punctuality (delivery on time as ordered) 
- Hygiene (clean truck, clean cases, etc. …) 
- Friendliness (the driver is friendly) 
- Flexibility (emergency orders are possible) 
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- Completeness (deliveries are complete) 
- etc. … 

 
To define these labels please open System > Configuration > [CUSTOM]: 
 

 
 

Here you can find the parameters SupplierAssessmentCrit 1 – 10: 
 

 
 

Enter the description for the criteria to be shown in the Assessment and click OK. 
After defining the criterias please re-open the module Supplier Assessment. 
Select a supplier and click again on “New Assessment”: 
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Now you can enter the grades for each of the criterias. The grades are measured in 
numeric values with up to three decimals. Please keep in mind that lower grades are 
considered as good and higher grades are considered as negative. 
Click OK once finished. 
 

 
 
The grid now shows the following information: 
- Date:  The exact time stamp when the assessment was created. 
- Created by: The user who has entered the assessment 
- Criterias: Entered grades for the defined criterias 
- Average: The average value of the entered criterias 

NOTE: Do not enter 0 in case of no grade, as this will influence the 
average calculation! 

- Info:  The text entered in the Assessment dialog 
- Changed by: The user who has changed the assessment last 
- At:  The date of the last change. 
 
 
The results of this assessment will be visible in the Bid Management screens (see 
previous chapters) and will help to select the right supplier for the quotes. 
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Article Assessment: 
 
This module is designed to store assessments of articles and samples provided by the 
suppliers. Selected users can assign grades/scores for pre-defined criterias to the 
samples. 
These assessments could be done as blind tests, meaning the testers do not have 
knowledge which supplier produced the sample. 
The result of these assessments can be used in the Bid Management to select the best 
possible articles. 
 
This module consists of mainly two parts: 
- Setup of Article Assessments 
- Entering results 
 
The main workflow for such an Article Assessment will be like this: 
 
- The purchase manager creates a new Article Assessment 

o Adding testers to the assessment 
o Adding supplier, units and prices 

 
- Users having access to the system will select the article and print the blind test sheet. 

 
- For users not having access to Materials Control the purchase manager should print 

the blind test sheets. 
 

- The blind test takes place and all users should enter their results into the sheets. 
 

- The results are entered into the system: 
o Users having system access will enter their results in Master Data > > 

Articles without being able to see the supplier information. 
o For users not having access to the system an authorized user must enter the 

results in the Article Assessment module in the Bid Management. (These 
users can see the supplier information.)  
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User Rights: 
 
Three user rights are available for this module: 
 
 

 
 
The first two rights are valid for the part located in the module Bid Management:  
 
View Article Assessment: Having this right the user can view entered 

assessments and their results. 
 
Edit Article Assessment: Having this right the user can create new 

assessments, edit existing ones and also enter 
results for other users. 

 
NOTE: The user must have the user rights “Purchase Bids” to access the main module in 
general, also before he could start the Article Assessment! 
 
 
Enter Assessment Results: This third right should be set for users just entering 

their own results or for other users as well. 
 

o In combination with the rights “Purchase Bids” and “View Article Assessment” 
the user can enter results for other users in the Article Assessment module in 
the Bid Management. But he cannot change any other details of the 
assessment. This should be set for the administrators of the assessment. 
 

o In combination with the right Master Data > “Articles” the user can access the 
blind test module located in the Article module. This should be set for the 
“normal” testers assigned to an assessment. 
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Setup of Assessments: 
 
This module could be used with or without the Bid Management. In order to activate this 
for the Bid Management as well please open System > Configuration > [CUSTOM]: 
 
Here you can find the parameter ARTICLEASSESSMENT. 
 

 
 
Set this parameter to T in order to activate the use of this module in the Bid Management. 
 
Start the module Bid Management and select from the main menu the section 
“Assessment”. Here you can find the module “Article Assessment”. 
 

 
 
Start the module: 
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In the header section the article must be selected.  
In the grid below the details of the assessment are displayed. 
 
Select any article and click on “New Assessment”: 
 

 
 
The system now asks for a title for this assessment and the date. Enter the details and 
click on OK. 
 

 
 
Now the header information for this assessment is saved in the grid. Here all 
assessments for this article will be visible. 
 
Double click on the record in the grid. 
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The application will now switch to the next tab “Testers”. Here the testers for this 
assessment can be defined. 
 
Please note that only the testers defined here will be able to enter the results for this 
assessment in the article module later on. 
 
Once all testers are added, please switch to the next tab called “Edit Template”: 
 

 
 
Here the details of all samples for the testing should be entered. 
- Supplier (not visible while entering details) 
- Unit 
- Price 
- Sequential Number (for sample identification) 
 
 
Once all suppliers are listed, please switch to the tab “Summary” 
 

 
 
At a later stage this tab will show the summary of the entered results. 
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Similar to the Supplier Assessment the criterias for the assessments must be pre-defined 
in the configuration now. 
 
The labels for the 10 fields are free definable, but are valid for all Article Assessments.  
 
They should show the criterias you want to use for the assessments, such as… 
- Visual Appearance (How does the article look in general?) 
- Colour (Is the colour as expected?) 
- Texture / Consistence (Does it “feel” as expected?) 
- Taste (Does it taste as expected?) 
- Smell (Does it smell as expected?) 
- Weight (Is the weight as expected?) 
- etc. … 
 
To define these labels please open System > Configuration > [CUSTOM]: 
 

 
 
Here you can find the parameters ArticleAssessmentCrit 1 – 10: 
 

 
 
Enter the description for the criteria to be shown in the Assessment and click OK. 
 
Now the main Article Assessment could start. 
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Entering Blind Results: 
 
The purchase manager (or the user responsible for the assessment) informs all user 
listed as Testers in the Article Assessment. 
 
These users now should open MC, go to Master Data > Articles and open the article they 
should test. 
 

 
 

At the very right end of the tab list the Article Assessment can be found (see section User 
Rights). 
 
If the user was defined in the Assessment setup, he will be able now to participate in the 
assessment. If the user is not defined in the Assessment setup, no records for testing will 
be shown! 
 
The user now should print his test sheet and go to the Assessment: 
 

 
 

On this test sheet the user now can see the main description of the article, the units for 
the (here) 4 samples and their prices. Next to this there are the 10 columns to enter the 
results; the legend for the columns is visible at the bottom. Please keep in mind that lower 
grades are considered as good and higher grades are considered as negative. 
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The supplier, of course, will not be visible, as this could influence the result. 
 
Once all critieria have been rated the user now can enter his results into the system in the 
module Manage Articles: 
 

 
 
- either click directly into the grid 

… or 
- in the dialog window after double click on the records: 

 

 
 
At the end of the grid the system will calculate the average grade for each sample. 
 

 
 
Right next to this field the free text comment is shown. 
 
Save the results. 
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Entering Results for other Users: 
 
Sometimes not all users participating at the Assessment are “normal” system users. For 
these users the Assessment administrator could pre-print the test sheets directly from the 
Article Assessment Setup screen. 
These users just needed to be created in the Materials Control database and to be 
defined in the Assessment. 
 
Open the assessment in the Bid Management module and switch to the tab “Testers”: 
 

 
 
At this point you need to double click the user name: 
 

 
 
The system will switch the identity of the user but only for this segment. You can now 
print the test sheet: 
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This way the assessment administrator could print all test sheets if necessary. 
After completion of the assessment the results noted on the test sheets for each user can 
be entered into the system. 

Summary: 
 
After all testers have entered their results (direct or indirect), the assessment 
administrator could review the summary of the Article Assessment.  
Check the tab “Summary” for the just completed assessment: 
 

 
 
Here now the system shows the average results per sample, but also including the 
supplier name (since the purchase manager will need this for his decision). 
The grid shows … 
- … per field the average result from all testers 
- … at the right end of each record the average result of all criterias for the sample 
 
 
The result of this assessment will be visible in the Bid Management screens (see 
previous chapters) and will help to select the right supplier for the quotes. 
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Bid_Mode 2: 
 
Currently not fully supported. 
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